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Chapter 1

MultiTool Il V1.5

1.1 Docs for MultiTool Il V1.5 ©1993 by Boris Jakubaschk

MultiTool II
V1.5
08.09.1993
— Shareware Release-—

MANUAL

CONTENTS:
For all those who never read manuals...
1. Disclaimer Adress Thanks
Shareware information
2. Introduction
3. Basics
4. File lists
5. Copy, Move, Delete
6. Selections
7. Archives
8. Analyze and Action
9. Menu
10. Configuration

11. Other features
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1.2 For all those who never read manuails...

I will note some important things in short. Otherwise I must
answer the same questions again and again!

— MTool is shareware. If you use it frequently, you should pay US$20
for registration. I will send you a keyfile and one free Update
then. Future releases of MTool will be crippled and more expensive.
Register NOW!

- You can give MTool to anyone you want if you don’t ask money for it.

— The first line in every file list is displayed in bold, because
you can use the cursor keys to control the file lists. The entry
shown in bold is used as a cursor.

— The backtick ("'", below ESC) switches the devicelist gadget to an
alternative list (configurable).

— Press Space to change the active file list.

— There are invisible Parent-gadgets at the left and right window
borders.

— "Hide" in the Project menu closes the window of MTool. It reopens
by pressing the Hotkey Ctrl-Alt-"<".

If you didn’t understand a single word now, you should consider read-
ing the complete manual ;-)

1.3 Disclaimer

1. Legal Matters:

The author cannot be held liable for the suitability or accuracy of
this manual and/or the program it describes. Any damage directly or
indirectly caused by the use or misuse of this manual and/or the
program it describes is the sole responsibility of the user her-/
himself.

MultiTool II, © Copyright 1992 Boris Jakubaschk. All rights reserved.

This program is SHAREWARE so if you use it frequently, you should pay
a registration fee of US$20. This program may be freely distributed
as long as all documentation and executables remain unchanged and are
included with the distribution. Also no profit is to be made by
selling this program.

You may however:

- Give MTool to your friends.

- Upload it to any mailbox or network, where the users don’t have to
pay for downloads (FIDO, FTP).

— Include it in any non-commercial PD collection.
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The following files should have come along with MTool:

MTool — The program itself
MTool.info - Its icon
ENVARC/MTool.Prefs

- An example preferences file
Catalogs/deutsch/mtool.catalog

- German catalog file (>=0S2.1)
Catalogs/espafiol/mtool.catalog

- Spanish catalog file (>=0S2.1)

MTool_D.guide - German documentation
MTool_GB.guide - This text
MTool_E.guide - Spanish documentation

MTool_D.History How MTool developed (German)
MTool GB.History - How MTool developed (English)

MTool .DESC — Description for file lists in mail boxes (German)

Install_ D — Installation script for commodore’s installer
(German, installer not included)

Install_GB — Installation script for commodore’s installer
(English)

Install E — Installation script for commodore’s installer
(Spanish)

Localesource/#? - Catalog sources

In the original archive of MTool I also included the text/hex viewer
MI written by Andreas Baum (Sunnysoft). It is installed together with
MTool if you use the installer script. You can redistribute both
programs (MI and MTool) separately if you want.

All files must be redistributed unchanged!

If you are able to translate the locale files for MTool to another
language, please do it and send me the result. The locale source

can be found in "Localesource/...". Please translate only the contents
of MTool_d.ct. MTool.cd must remain unchanged.

MTool has been developed in a period of over one year and should no
longer contain any severe bugs. But: No big programme is absolutely
bug free. It would be nice if you would tell me of every bug that
you encounter. It’s the only way I can remove it!

If there are any bugs in the actual version, you can find their
description in the history file.

1.4 Adress

Please send bug reports, questions etc. to: Boris Jakubaschk
Neue StraBe 14/1
70186 Stuttgart

Germany

++49 711 462989

UseNet: Boris@alice.tynet.sub.org
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FIDO: 2:246/1115.2

1.5 Thanks...

MTool has been developed with the help of many friends and other
people who sent me bug reports and suggestions. Thank you!

Namely:

— Christopher J. Ellerbeck: For the English docs, locale file and
his numerous suggestions.

- José Garcia: For the Spanish docs and locale file.
— Stefan Boberg: For LHA.

- Matt Dillon: For DICE.

- Jan van den Baard: For GadToolsBox.

— Jens BOnisch, Matthias Hank, Bernd Johannes, Harald Schneider,
Holger Trapp and Erik Wende (in alphabetic order ;-)), my beta
testers.

- Andreas Baum, Rolf Damm, Marc Duponcheel, Christopher J.
Ellerbeck, José Garcia, Brian Jacobson, Christian Krenner,
Reinhard Kunter, Markus Monig, Marc Necker, Jochen Schiller
and Harald Schuler, who helped me with their bug reports and
suggestions.

1.6 Shareware information

This version of MTool is the last one without any restrictions. You
can use it as long as you want without any limitations. (I can’t
prevent this anyway.)

The next release will be crippled, its functionality will be reduced
by "Please register"-requesters. In addition, all new features are
visible but you can’t use them.

If you are a registered user, I will send you a keyfile. It will
remove all handycaps of the crippled version. Of course this keyfile
also works with future releases of MTool.

Please help me to continue the development of MTool by sending me
your registration fee. The price depends on my costs and your income:

normal pupils/

registrations students
registration fee UsSs15 Uss1o0
information and keyfile via e-mail free free

first update and keyfile via snailmail Uss 5 Uss 5
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You can pay an equivalent price in other currencies. When the money
arrives, I will send you a postcard (or e-mail) for confirmation.
When I have finished MTool V2.0, the keyfile comes UUEncoded via
e-mail or I send you a disk containing the program and the keyfile.

I prefer getting the money in cash. I know that there’s a risk
sending money in letters, but it’s the easiest way for me to get
DMs for it. Eurocheques (in DM!) are welcome, too. Other cheques
are very expensive to cash in.

Send it to: Boris Jakubaschk, Im Oschle 28, 78727 Oberndorf
Germany

1.7 Chapter 2

2. What is MultiToolII?

MTool is a directory utility like SID or DirOpus, written especially
for use with 0S2.0. It has fewer functions and options as the two pro-
grams mentioned, but it offers a new feature that I have never seen
before: MTool handles LHA-archives like directories. You can double-
click the name of a LHA-archive and its contents will be displayed

in the filelist. Files can be deleted or copied to and from the
archive.

MTool has been developed using the features of 0S2.04 and WB2.1l. It
works with WB2.04 (not localized, no screen mode requester); KS1.3

is no longer supported (sorry).

1.8 Chapter 3

3. Basics:

Perhaps you have never worked with a directory utility like MTool,
so I’11 describe the basics of such a programme in short.

As a user of MTool you should be familiar using the workbench and
the shell. Otherwise you will be able to confuse you and your system!

MTool provides the features and flexibility of the shell with the

comfort you know from using workbench. You can perform all actions
by mouse, including copying, moving and deleting files, displaying
pictures, editing text, etc...

After you have started MTool you should see two big empty boxes. They
will be used later to display file lists. On top of each file list is
a string gadget where the name of the current directory is displayed.
You can activate it by clicking it with the mouse. With this accomp-
lished you can type in a new directory name to be displayed. Below
each file list is a small box containing further information about
the disk belonging to the directory. It’s the free space on the disk
and its status ("OK": All right, "Prot.": write protection, "Vali":
Disk is not wvalidated, No writing allowed). At the side of this box
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you find a gadget with an "I" in it. Clicking on it makes a requester
to come up. It shows more information about the disk: The complete
capacity, the name of the disk and the size of the selected files and
directories.

If you click into one of the file lists, the status line below it
will be highlighted and the other one appears darker. In addition
the frome of the list is bevelled inward. This list is called the
active file list. You can change the active file list also by pres-
sing the "SPACE" key.

1.9 Chapter 4

4. Operations with the file lists:

Between the two file lists you see a column of different gadgets that
are used to perform all actions of the program.

On top of this column is the "Parent" gadget. If you click on it,

the active file list will show the parent directory of the one that
has been shown before, i.e. if you were in the "Workbench:devs/prin-
ters" directory and you click on "Parent", MTool will load the direc-
tory "Workbench:devs" and displays its contents. You can reach this
also by clicking on the left or right border of MTools window or by
pressing the cursor left key.

The "P" in the Parent gadget is underlined. This means that you
can also perform the action of this gadget by pressing the p key.
This is the same thing with all gadgets with underlined letters in
it.

Below the parent gadget you find a listview containing the names of
all devices, availible disks and the active "assignments". The list
will be updated whenever you insert or remove a disk.

If you select an entry of this list, its directory will be displayed
in the active file list.

1.10 Chapter 5

5. Copy, Move, Delete, Rename and Makedir:

The first three gadgets below the device list offer the biggest in-
fluence to the structure of your disks and the data stored on them
including the deletion of all files. Be careful!

Copy: All files and directories, that are selected in the active
file list are copied to the directory of the inactive file list. The
original data remains unchanged. Directories are copied with all
their contents.

Move: does the same as Copy, but with one big difference: Every
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original file is deleted after it has been copied. After moving the
selected files the originals in the source directory are deleted.

Delete: Kills all selected files and directories (including their
contents) in the active directory. There are tools like DiskSalv2 and
FixDisk that can bring back deleted files as long as you have not
written anything on that disk after you deleted some files acciden-—
tially.

Each of these three gadgets brings up a window. It’s used to control
the copying or deleting of the files. If you are shure, you want to
copy / delete all selected files, you can press the "return" key.
MTool will copy / delete all files without giving you the chance to
interrupt it.

Otherwise you will be shown all information of the actual file, that
are tagged in the top half of the window: Date, size and version.
You can also compare the file with a file of the same name that
already exists in the inactive directory. Additionally you can

tell if you want to confirm every file, if all files should be
copied / deleted without asking or (in case of copy) if you want to
be asked about files that already exist in the destination drawer.
If you select "Change name" you will be asked for a new name for the
file if it already exists.

Rename: There’s a window for every selected entry in the active file
list, where you can change the name of the file or directory. If you
want to abort this action for all selected files, just click on

the close gadget of the rename window.

"MakeDir" creates a new drawer in the active directory. In the
window you should type in the name of the new drawer.

1.11 Chapter 6

6. Selections:

The next three gadgets are used to select some of the entries in
the active file list. "All" selects all entries, "Nothing" clears
all selections.

Pattern: Brings up a string requester where you can type in a
AmigaDOS pattern. All files that fit with that pattern are selected.

Already selected entries stay selected. In your AmigaDOS manual you
find an introduction how to use patterns.

1.12 Chapter 7

7. Archives:

Archives are files containing some other files in a compressed form.
They are used mostly in data transfer by telephone to save time
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and to make it easier (transfer of only one file instead of dozends).

MTool is able to control all standard actions of the archiver "LHA".
LHA must be on your disk and you must include it to your prefs file
(see configuration).

7.1 Creating new archives:

If you want to create a new archive, you do the same as if you would
copy the files and directories you want to put into the archive.
Instead of selecting "Copy" you must select "Archive". Then you will
be asked for the name of the Archive. Afterwards, all selected files
and directories of the active file list are packed to an archive that
will be placed in the inactive file list.

7.2 Unpacking archives, deleting them partially or adding files:

If you have got an existing archive, you can double click its name
like the name of a directory. MTool will then display the contents
list of the archive. Subdirectories are not shown as subdirectories,
all files are displayed with their complete path.

Now you can treat this list as every file list: Copy, Move, Delete...
MTool will refuse to show archive contents in both file lists, because
copying files from one archive to another would have been too
complicated. It’s not supported by LHA. To do this you must unpack

the files first (i.e. to RAM:) and then pack them again.

Some actions can’t be used with archives, so their gadgets become
ghosted as long as there is an archive displayed in the active file
list.

1.13 Chapter 8

8. Analyze and Action:

You can make MTool analyze the selected files (not directories) by
selecting the "Analyze" gadget. The analyze window shows the name

of the file and a list of information that MTool found out about this
file.

On the right side you can see and manipulate the protection flags of
the file. The changes will only be written to the file, if don’t
"Cancel" the window.

Editor: Calls a file monitor (if you have one in your prefs file,
i. e. HEX, a shareware program by Nicola Salmoria).

Action: tries to do something useful with the file. Normally, a
program is started i.e. to display a picture. There are two more
possibilities to perform an action without seeing the analyze window
before: You can double click a file name in the file list or you can
click on the "action" gadget. In the first case, action will be done
for the double clicked file only, in the other case all selected
files are affected. In the moment, action works with ASCII-Texts and
LHA-Archives if MTool is set up correctly. Other file types can be
included in the config file. The demo configuration, you find in
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this distribution contains IFF-pictures, IFF-animations, MOD-files,
GFA-basic-programs, pagestream-documents, GIF-pictures, JPEG-pictures
and Icons.

1.14 Chapter 9

9. The Menu:

There are two major tasks for the menu: You can set up the screen
mode and the fonts for MTool for your needs. And you can include
external programmes to the "Tools"™ menu. This will be explained
later.

In the "Project" menu you find entries to display some information
about MTool and to leave the program. This can also be reached by
pressing "Amiga-g" or ESC.

"Hide" closes the window (and screen) of MTool. To open it again,
you must restart MTool, press its hotkey (default: Ctrl Alt "<")
or use the commodities exchange program.

The "Preferences" menu contains three different editors: two for
the fonts that are used for the gadgets and the file lists and one
for the screen mode. The latter is only availible if you use
Workbench 2.1 or higher. The other menu entries make it possible
to save the preferences, to load others and to enter some modes:

"CustomScreen" changes between the Workbench screen and an own public
screen.

"Quick start" makes the "Copy" action start immediately. Normally you
can enter the parameters for copying first.

"AutoDir" enables the updating of the file list when a disk is
inserted or removed. The file lists will then be updated too (if
necessary) .

As menitoned before, the "Tools" menu can contain additional programs
that you must include to the preferences file. How to do that is
described in the following chapter.

1.15 Chapter 10

10. Configuration:
10.1 External Programmes for "Action":

At startup, MTool looks for a preferences file "MTool.Prefs" that
must be located in "S:" or in "ENV:". If this file is missing, you
can’t perform any action. The preferences file has three tasks.
First of all it is used to attach external programs to different
file types.
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Every line in the config file starts with a four letter code followed
by a space. The rest of the line is a command string.

Example:
ASC SYS:Tools/HEX "%s"

The code "ASC " stands for ASCII texts, the command line will be
executed, if you doubleclick a text file from within MTool. The

no

%$s" will then be replaced by the file name.
Here is the complete list of codes:

2?2?22 : Unknown file type

ASC : ASCII text

HXED : file editor

LHAx SYS:xc/LHA -r x "%s" Q@T:MT_Temp "%s"
LHAa SYS:xc/LHA -r a "%s" @T:MT_Temp
LHAd SYS:xc/LHA d "%s" @T:MT_Temp

LHAl SYS:xc/LHA >T:MT_Temp -N vv "%s"

The last four lines must be included in your config file if you want
to use the LHA support of MTool. Of course you must replace the path
"SYS:xc/" with the path of the LHA archiver in your system.

There is another way of making MTool react to special file types.
The corresponding key words may appear multiple in the config file:

TYPE #pattern#description#command
FILT #start of file (ASC)#description#command
HFIL #start of file (HEX) #descriptionf#command

When analyzing a file or trying to find an action for a file, MTool
searches all TYPEs, FILTs and HFILs to find one that matches the file.
In case of TYPE, the file name is compared to the pattern. Example:

TYPE ’#?.guide’AmigaGuide document’SYS:Utilities/Multiview "%s"

Instead of the numer sign (#), the apostrophy (') is used here. You
can use every character, but it must be the same everywhere in the
line and it mustn’t occur elsewhere in the line. The file name is
compared with the pattern #?.guide, meaning if the file name ends
with .guide, it will be recognized as an AmigaGuide document (Analyze)
and processed by the program Multiview (Action).

FILT and HFIL read the beginning of the file and test it. Example:
FILT #FORM????ILBM#IFF picture#SYS:XCli/VT "%s"

The first 12 Bytes of the file are read. It must start with ’'FORM’,
followed by any four characters (symbolized by question marks). Then
there must be the chars "ILBM’. If a file matches to these conditions,
it will be recognized as an IFF picture and displayed by the programme
"VT’ . This method works only with files that start with ASCII values.
Therefore the last version of finding out a file type was made:
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Example:
HFIL 'E3100001’Icon (#?.info)’Work:Graphik/Iconedit "%s"

In this case, every Byte of the file is represented by two Hex digits.
You can also use the question mark as a wild card. The Hex number can
be of infinite length.

10.2 Screen modes etc.:

As I mentioned before, there are other tasks for the preferences file:
You can enter the screen mode and the fonts at startup. This part

of the file looks exactly as described before. The order of these
lines is unimportant.

The codes:

SCRw : Width of the screen
SCRh : Height of the screen
SCRm : Screen mode as a number (best in HEX with leading "O0x")
(i.e.: 0x19000: NTSC Hires, 0x19004: NTSC Hires interlaced
0x29000: PAL Hires , 0x29004: PAL Hires interlaced
0x19024: NTSC Superhires interlaced...)
SCRt : Screen type "CUSTOM" for a custom screen, any other for
Workbench.
WNDx : Distance of the window to the left side of the WB screen
WNDy : Distance of the window to the top of the WB screen
WNDw : Width of the window on the WB screen
WNDh : Height of the window on the WB screen
FNGn : Name of the font used for gadgets.

FNGs : ... and its size
FNLn : Name of the font used for the file lists.
FNLs : and its size

CMod : Copy mode. This parameter is coded and should not be changed
manually. Just set up the copy / delete window as you like
it and save the prefs from within MTool.

ADir : Y or N, like menu entry AutoDir

DIRO : Name of the directory that will be displayed in the left
file list just after startup

DIR1 : Same, but for the right file list

If a screenmode is entered without width or height, the standard
overscan values will be used. If SCRw, SCRh or SCRm are included,

a custom screen will be opened automatically, if no "SCRt WORKBENCH"
is found.

The custom screen is a public screen named "MTOOLSCREEN".

You should not change these parameter as long as you are not absolutely
shure of what you are doing. There are no security checks and your
Amiga can be crashed by extreme values!

The easier way is to change screen mode and fonts from within MTool

and to save the prefs then.

10.3 External programs in the "Tools" menu:

The last task of the prefs file is to include up to ten external
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programs in the "Tools" menu. To achieve this, you must put lines
of the following type in MTool.prefs:

MENU #command line#control string#menu name

The command line can contain up to three "%s"’s that will be replaced
by strings depending on the control string. Each character of the
control string (logically up to three) defines the replacement for
one "%s". The menu name is displayed in the "Tools"-menu.

The characters in the control string are as follows:

D: Directory name of the active file list

d: Directory name of the other file list

F: Makes MTool call the command line repeatedly, once for each selected
entry in the active file list. replacement is the file name

f: Same with the other file list.

L: Creates a temporary file in T: that contains the names of all
selected entries in the active file list including path names.
replacement is the name of the temporary file.

1: ...

N: Same as "L", but the path names are omitted.

n: ...

S: Replacement is asked for by a string requester

Example:

MENU #C:Protect "%s" %$s#FS#protect files

This will create a menu entry named "protect files". Assuming you
have selected the files "startup-sequence" and "user-startup" in
the active file list ("s:") and are calling this menu entry, you
will get a string requester. If you enter "+s", MTool will execute

the following commands:

C:Protect "s:startup-sequence" +s
C:Protect "s:user—-startup" +s

Afterwards, both files will have their script bit set. Voila.

10.4 Configurable device list:

If you press the backtick key ("'", below Esc), you will see the
configurable device list. The entries can be defined in MTool.prefs.
You must include a line of the following form for each entry:

CDEV ’'name in list’path

The name will appear in the configurable device list then. If you
select it, the path will be shown in the active file list.

Example:

CDEV ’Letters’/Work:FinalCopy/documents/letters
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1.16 Chapter 11

11. Other features:
11.1 Keyboard control:

Sice version 1.3 of MTool, it can be controlled almost completely

by keyboard. Most important are the cursor keys. They control the
active file 1list. The list entry that is shown in bold letters

is used as a "cursor". The key "cursor left" brings up the parent
directory, "cursor right" performs "Action" to the bold entry, meaning
if it’s a directory, the files will be shown, if it’s an archive,
the contents will be displayed.

So the control works exactly the same as with the file requester MFR
from Stefan Stunz.

You can select entries by holding the SHIFT key while moving through
the file list. Unselect is done by holding the ALT key. You can
change the active file list by pressing the SPACE key.

11.2 Commodity:

Commodity support has been included in V1.5 of MTool. This introduced
a new menu entry in the project menu: Hide. If you select it, MTool
closes its window (if MTool runs on an own screen, it will be closed,
too). It remains in memory, though. You can reopen the window by
pressing the hotkey (Default: Ctrl Alt <), using commodities exchange
or by starting it again. The second MTool will wake up the first one
and exit quietly. You will shortly need memory for two MTools.

You can change the hotkey by entering "CX_POPKEY=key combination” in
the tooltypes of MTool or by supplying it as a parameter (Shell).
"CX_POPUP=no" lets MTool keep its window closed after startup. So

you can put it in your WBStartup drawer and it is ready to use with

a simple keystroke.
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